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Abstract

For slender and lightweight structures, vibration serviceability is a matter of growing concern, often constituting the critical design requirement.
With designs governed by the dynamic performance under human-induced loads, a strong demand exists for the verification and refinement
of currently available load models. The present contribution uses a 3D inertial motion tracking technique for the characterization of the in-
field pedestrian behavior. The technique is first tested in laboratory experiments with simultaneous registration of the corresponding ground
reaction forces. The experiments include walking persons as well as rhythmical human activities such as jumping and bobbing. It is shown
that the registered motion allows for the identification of the time variant pacing rate of the activity. Together with the weight of the person and
the application of generalized force models available in literature, the identified time-variant pacing rate allows to characterize the human-
induced loads. In addition, time synchronization among the wireless motion trackers allows identifying the synchronization rate among the
participants. Subsequently, the technique is used on a real footbridge where both the motion of the persons and the induced structural vibrations
are registered. It is shown how the characterized in-field pedestrian behavior can be applied to simulate the induced structural response. It
is demonstrated that the in situ identified pacing rate and synchronization rate constitute an essential input for the simulation and verification
of the human-induced loads. The main potential applications of the proposed methodology are the estimation of human-structure interaction
phenomena and the development of suitable models for the correlation among pedestrians in real traffic conditions.

Video Link

The video component of this article can be found at http://www.jove.com/video/53668/

Introduction

Driven by the economic demand of efficiency and the increasing strength of (new) materials, architects and engineers are pushing the limits
to build ever longer, taller and lighter structures. Typically, light and slender structures have one or more natural frequencies that lie within the
dominant spectrum of common human activities such as walking, running or jumping. Likely to be subject to (near-)resonant excitation, they are
often unduly responsive to human motion, resulting in disturbing or even harmful vibrations1. For these slender and lightweight structures, the
vibration serviceability is a matter of growing concern, often constituting the critical design requirement.

The human motion and the resulting ground reaction forces (GRFs) are usually experimentally identified in laboratory conditions. Currently,
designers are forced to rely on — what are assumed to be 'conservative' — equivalent load models, upscaled from single-person force
measurements. With designs governed by the dynamic performance under high crowd densities, a strong demand exists for the verification and
refinement of the currently available load models.

The present protocol employs a 3D inertial motion tracking technique for the characterization of the natural motion of pedestrians. It is shown
how this information can be used to define the correlation among the pedestrians as well as the corresponding induced loads. In a subsequent
step, the characterized pedestrian behavior is used to numerically simulate the induced structural response. Comparison with the registered
structural response allows to quantify the effect of unaccounted human-structure interaction phenomena, e.g., the added damping due to the
presence of the pedestrians. The methodology is illustrated for full-scale experiments on a real footbridge where the structural response and the
motion of the participants are registered simultaneously.

Protocol

All procedures were approved by the ethical committee of the university hospital of the KU Leuven and each subject gave a written informed
consent prior to participation.
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1. 3D Motion Tracking: Configuration and Data Acquisition

1. Ensure that the individual sensors are fully charged (Figure 1A). This step takes about 1 hr but can be performed on the days prior to the
actual measurements. Follow the manufacturer's charging protocol.

2. MT Manager — Data acquisition2:
1. Enable the wireless connection with the sensors and specify the desired sample rate (Wireless Configuration > Enable all wireless

masters).
 

Note: To allow for an accurate characterization of the pedestrian behavior, a sampling rate of at least 60 Hz is advised. The individual
sensors record 3D linear acceleration, angular velocity (earth) magnetic field and atmospheric pressure data.

2. Activate the operational mode and initiate the measurement mode: make slow movements with the sensors for about 1 min (Wireless
Configuration > Start measurement on all wireless masters).

3. Display inertial and magnetic data of all active sensors (View > Display > Inertial Data). Make sure that, while stationary, the orientation
of the sensor does not chance.
 

Note: A changing orientation of the stationary sensor would indicate a magnetically disturbed environment and, thereby, inaccurate
orientation information.

3. Orientation reset: Apply an object/heading reset (Object/heading reset > Reset orientation) to define the global reference frame of the
experiments (Figure 1B) 2.

4. Place the sensor as close as possible to the body center of mass (CoM) located at the level of the fifth lumbar vertebrae (Figure 1C). Fasten
a single sensor tightly and robustly onto each participant with specially designed click-in full body straps (Figure 1C).

5. Record data as required.
6. Load the records of interest (open file), specify the export settings (Tools > Preferences > Exporters) and export the acceleration (and

orientation matrix) data for subsequent analysis2 (File > Export).

2. Force Plate: Setup and Configuration

Note: The present step discusses the application of a force plate to register the GRFs. In the case that a walking/running person is involved,
a series of force plates or an instrumented treadmill is to be used to register the loading induced by subsequent steps3, the protocol itself is
analogous.

1. Ensure that the force plate is securely fixed to the laboratory floor (Figure 2).
2. Configure the device and acquisition settings4 (NDI Open Capture > Data > Device Settings > Settings). Select the proper "gain" and "sample

rate". Configure and check the external trigger settings, if required4.
1. Choose the gain and sample rate in accordance with the desired accuracy and the involved loading type. For the present application,

use a gain of 128 (Maximum Force 4,879 N) and a sample rate 200 Hz.

3. Start and end each trial with an empty force plate: Tare the force plate when empty (NDI Open Capture > Data > Device Settings > Settings >
Tare).

4. For verification purposes: Place a known weight on top of the force plate before and after each trial.
 

Note: In the present application a mass of 5 kg is used, however, the use of another well-known rigid mass (> 2 kg) can equally serve this
verification test.

5. Record and save the GRF data as required. Export the GRFs for subsequent analysis4.

3. Measurement of the Structural Accelerations

Note: The present steps aim to collect the structural vibrations at one or more relevant locations on the structure. The present application
employs GeoSIG GMS recorders (Figure 3) to register the structural accelerations. Other sensor types with proper characteristics for the
involved application, can be equally applied.

1. Ensure that the individual sensors are fully charged. This step can take several hours but can be performed on the days prior to the actual
measurements. Follow the manufacturer's charging protocol.

2. Install the sensors on the desired locations of the primary structure: level the sensors and, if necessary, provide proper fixation to the primary
structure (e.g., by using magnets).
 

Note: given the high mass of the individual GMS recorders (> 6 kg) and the involved low-frequency oscillations (< 6 Hz), no additional fixation
was necessary in this case.

3. For GeoDAS Data acquisition5: Configure and enable the wireless GMS network and connection with the sensors5. Check time settings and
synchronization settings (if necessary) (right click on the sensor > More information).

4. Position the sensors on the desired location and level them in agreement with the global reference frame.
5. For GeoDAS Data acquisition5: Export the recorded data for subsequent analysis (right click on the sensor > Instrument Control > Send a

request > User request > GETEVT5).

4. Experiments in a Controlled Laboratory Environment

1. Configure / Setup 3D motion tracking (as discussed in section 1).
2. Configure / Setup force plate (as discussed in section 2).
3. During operation: visually check the real-time measurements of both the wireless inertial sensors and the force plate to verify their operational

mode.
4. Ask the participant to step onto the force plate and stand still for at least 30 sec: this allows to identify the weight of each individual.
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5. Configure the metronome signal: select the desired rhythm, i.e., fundamental forcing frequency.
 

Note: The metronome signal can be easily configured using free online or smartphone applications.
6. Start recording the data of both the force plate and the wireless inertial sensors.
7. Ask the participant to initiate the desired activity: walking, jumping or bobbing at the (targeted pacing) rate as indicated by the metronome

signal (see Figure 4).
8. Record the chosen number of loading cycles, e.g., steps, jumps or bobbing cycles. Ask the participant to get off the force plate.

 

Note: For validation purposes it is advised to consider some additional recording time in these unloaded conditions. In literature, there is no
clear consensus about the minimum number loading cycles required to characterize the cycle-to-cycle variabilities6. Based on experience
and the work presented in [6], the study presented here considers 60 consecutive cycles whereby the first and last five loading cycles are
excluded from the further analysis to exclude irregularities in the loading pattern at the start and end of the trial.

5. Experiments In Situ

1. Configure / Setup the network of 3D inertial sensors that track the motion of the participants (see section 2 and Figure 5).
2. Configure / Setup the GMS network of wireless accelerometers that register the structural accelerations (see section 4).
3. During operation: (visually) check the real-time measurements of the wireless inertial sensors to verify their operational mode.
4. Define a clear protocol that allows to synchronize the involved measurement systems, if required.

 

Note: This step is necessary when the involved data acquisition systems do not allow for direct synchronization due to the lack of a trigger or
common channel. The latter is the case for the wireless measurement systems applied in the in situ experiments (5.1 and 5.2). Therefore, a
clear protocol has been adopted on site that allows to synchronize the datasets offline. In the present application, the involved measurement
systems are synchronized through registration of an identical event, i.e., impact, at the beginning and end of each trial, registered by at least
one sensor of each of the involved measurement systems. Properly aligned time vectors are subsequently obtained through offline alignment
of these events.

5. Configure the metronome signal: in situ, the use of a megaphone to amplify the targeted beat is required.
6. Collect a sufficient number of trials to check the repeatability of the experiment. Based on experience, the authors recommend to record at

least 3, or preferably 4, trials.

6. Data Analysis

1. Pre-process the raw data of the involved equipment as required: Apply the proper filters to remove undesired influences such as irrelevant
high-frequency contributions and measurement noise, and retain the relevant time window according to manufacturer's protocol.
 

Note: The filtering characteristics should be chosen in accordance with the application. In the present study, the MATLAB Signal Processing
Toolbox7 is applied to perform a low-pass filtering with a cut-off frequency at 20 Hz for all involved signals.

2. For each participant: Compute the discrete Fourier transform of the registered accelerations of the CoM using MATLAB Signal Processing
Toolbox7 and identify the average loading frequency as the frequency of the dominant peak of the fundamental harmonic in the obtained
spectrum.

3. Identify the time in between any two nominally identical events of the load cycles using the method detailed in [3] or the lc_timing tool of the
PediVib MATLAB toolbox8

1. Load the data vector (lc_timing > Load).
2. Specify the sampling rate and estimate the average loading frequency. Specify the relevant time window, if required. Save the identified

timing of the nominally identical events, i.e., load cycles (lc_timing > Save).

4. Compute the average loading frequency as the inverse of the average time in between the subsequent load cycles (as identified in 6.3).
5. For the experiments in the laboratory: Apply the procedure detailed in 6.3 for both the resulting ground reaction forces and the accelerations

registered at the CoM of each individual.
 

Note: This step serves as validation for the procedure as applied for the in situ experiments where the GRFs cannot be measured directly.
The method detailed in [3] shows how the time variant pacing rate of the pedestrian can be identified by characterizing the relation between
the accelerations registered near the CoM of the individual and the consequent GRFs.

6. For the experiments in situ: Apply the procedure detailed in 6.3 for the accelerations registered at the CoM of each individual.

7. Simulation and Analysis of the Structural Response

Note: The subsequent steps are performed using MATLAB7. The structural response is computed using the PediVib toolbox, a MATLAB toolbox
developed by the authors8 (Figure 6): the human-induced forces are determined through application of the generalized load models of defined
by Li et al.9 (walking) and Bachmann et al.1 (jumping, running and vandal loading), and the structural model is formulated in modal coordinates10.
The accompanying manual includes tutorials that clearly illustrate the following steps.

1. Simulation of the structural response
1. Define the modal parameters of the test structure: Natural frequencies, modal damping ratios, mass-normalized modal displacements,

coordinates of the corresponding nodes (PediVib > Structural parameters > New). Visually check the modal input information (PediVib
> Structural parameters > View).

2. Define the characteristics of the pedestrian and the corresponding induced loads: load type, weight, walking path/location, average
pacing rate, onset of each load cycle (PediVib > Single pedestrian > New). Run and save the simulated structural response for the
involved participants. Visually check the results (PediVib > Single pedestrian > View).
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2. Compute the total structural response through superposition of the individual responses, i.e., summation of the corresponding vectors, and
compare the result with the measured structural response, e.g., by creating a figure which displays the measured and simulated structural
response.

Representative Results

First, it is shown how the accelerations registered near the CoM of the individuals can be used to characterize the consequent GRFs. The
results are discussed here for a walking individual3. Fully comparable observations are made when rhythmical human activities, i.e., jumping
and bobbing, are considered. Figure 7A and 7B show that the amplitude spectrum of the continuous vertical foot forces and the corresponding
acceleration levels registered near the CoM of the pedestrian are qualitatively highly similar, i.e., in shape and frequency. The average
pacing rate of the activity can be identified as the frequency of the first dominant peak in these spectra. Analysis of the registered GRFs and
accelerations of the CoM shows that the same average pacing rate is in this way identified up to ±0.1%. Subsequently, the timing of nominally
identical events is identified from the GRFs and the accelerations near the CoM, respectively. This procedure is illustrated in Figure 8 where the
GRFs and the accelerations of the CoM are normalized to the weight of the person and gravity of Earth (g = 9.81 m/sec²), respectively. Analysis
of the different trials shows that in this way, the period of each cycle and, thus, the time-variant pacing rate of the activity, can be identified from
the accelerations of the person's CoM with a 95% confidence interval that is lower than 3% in comparison to the one as identified from the
registered GRFs (see Table 1)3. Accounting in addition for the start time of the initial loading cycle, allows to compute the onset of all loading
cycles.

Next, this information is applied to simulate the GRFs using the PediVib toolbox8. Figure 9 visualizes small quantitative and qualitative
differences between the measured and simulated vertical single-step foot forces. These small dissimilarities are the result of applying a
generalized single-step load model as defined in literature9 and could be minimized by applying the averaged vertical single-step foot force of
the considered person for the corresponding walking speed. However, direct force measurements are generally not available for the persons
involved in the experiments in situ. In addition, in comparison to small variations in the pacing rate, the sensitivity of the induced structural
response to small variations in force amplitude or contact time can be considered neglegible3,11. Figure 9 also shows that the timing of the
footsteps, and therefore, the time-variant pacing rate, is accurately identified from the registered motion of the pedestrian. Figure 10 presents
the amplitude spectrum of the simulated and measured GRFs. In contrast to the perfectly periodic forces that are exclusively composed of the
harmonics of the step frequency, the small variations in pacing rate result into a distribution of forces around the dominant harmonics12,13. By
taking into account the identified variable pacing rate, these narrow band forces are also present in the simulated forces (Figure 10). Two scalar
quantities are subsequently used to represent the similarity between the amplitude spectrum of the measured  and the simulated forces

: (1) the linear rank or correlation  [-] which varies between 0 and 1 and for which 1 reflects a perfect correlation, and
(2) the normalized 2-norm [%]:
 

The amplitude spectra are compared in the frequency range relevant for low-frequency civil structures (0-10 Hz). Figure 10 shows that a high
correlation coefficient of more than 0.96 is found. Assuming the walking behavior to be perfectly periodic, results into a linear correlation of less
than 0.5. The normalized 2-norm is approximately 20%, where this remaining discrepancy is primarily the result of applying a generalized single-
step load model. For reference purposes it is noted that when the GRFs are simulated with the identified average single-step walking load, the
correlation increases up to 0.99 and the corresponding 2-norm with respect to the actual registered forces decreases to less than 8 percent. In
this way, analysis of the different trials shows that simulations based on the generalized load models and the identified time-variant pacing rate,
allow for a good approximation of the imperfect real GRFs induced by the human motion.

In addition to the characterization of the individual induced loads, the time synchronization of the wireless motion trackers allows to analyze the
synchronization rate among the participants. The synchronization rate  [-] is defined as:
 

 

where Ts [sec] is the period of the activity and Δts [sec] is the time shift between the cycles of different participants. This synchronization rate
is only relevant when comparable load cycles are involved. The time shifts Δts are therefore only considered for the cycles occurring within the
relevant time window [t - ½Ts < t < t + ½Ts]. As a result, the synchronization rate  can vary between zero and unity, whereby the latter depicts
perfect synchronization. This procedure is illustrated for the experiments involving six pedestrians for which the same step frequency is imposed
using a metronome (see Figure 5B). Figure 11A represents the identified onset of each loading cycle of every participant by a single vertical
line. Coinciding lines, as observed during the first 40 sec, indicate a high rate of synchronization. Scattered lines, as observed between 50 and
60 sec of the considered trial, indicate a low rate or loss of synchronization among the participants. Similar observations can be made from
Figure 11B presenting the corresponding synchronization rate and Figures 11C and 11D where the identified time-variant pacing rate is applied
to simulate the induced vertical loads.

Finally, the protocol is applied to perform a detailed analysis of the vibrations induced by human activities on the Eeklo footbridge (see Figure
5). Figure 12 presents the modal characteristics of the first six modes of the structure. The experiments involve people walking3, jumping
and bobbing with a pacing rate imposed by a metronome and targeted at the fundamental or second natural frequency. The response of the
structure is registered using five triaxial sensors (see Figure 3 and 5B). Subsequently, the measured structural response is compared with the
numerical simulations that account for the calibrated numerical model of the structure, the experimentally identified modal damping ratios and the
characterized in-field pedestrian behavior.
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First, the results are discussed for the experiments involving six pedestrians whose step frequency is chosen to match the first (fs = f1 = 1.71
Hz) and the second mode (fs = f2/2 = 1.49 Hz) of the structure. The pedestrians are arranged asymmetrically (all lined up one by one) or
symmetrically (two by two) with respect to the longitudinal axis of the structure to maximize the excitation of the first and the second mode,
respectively (see Figure 12). To illustrate the impact of the actual imperfect walking behavior of the participants, the structural response is first
predicted assuming perfectly periodic walking forces. Second, intra- and inter-person variabilities are taken into account by considering the
identified time-variant pacing rate and, thereby, also the true synchronization among the pedestrians.

Figure 13A presents the measured and simulated vertical acceleration at midspan for the persons walking two by two, with a pacing
rate targeted at f2/2. This figure illustrates that when the walking behavior is assumed to be perfectly periodic, the structural response is
overestimated by more than a factor of four. Accounting for the true imperfect walking behavior improves the agreement with the measured
response significantly although the predicted vibration levels are three times larger.

Figure 13B presents the measured and simulated acceleration at midspan for the persons walking on one side of the bridge, with a pacing rate
targeted at fs = f1. In this case, the registered and simulated lateral response at midspan is presented, i.e., the dominant component of the first
mode. Figure 13B shows that when the moving force model is applied and perfectly periodic walking behavior is assumed, the peak value of
the acceleration response is overestimated by a factor of two. A decrease in the measured acceleration is observed after about 40 sec due to
a reduced synchronization of the pedestrians. A similar tendency is also reflected in the simulated response when accounting for the identified
time-variant pacing rates. The latter leads to a much better qualitative agreement with the measured response that is, however, still slightly
overestimated.

Figures 14 and 15 present a similar comparison of the measured and simulated structural response involving jumping and bobbing, respectively.
Again, it is observed that the structural response is highly overestimated when the human-induced loads are assumed to be perfectly periodic.
Accounting for the identified time-variant pacing rate leads to a much better qualitative agreement with the measured response.

The remaining discrepancy between the measured and simulated structural response may be due to errors in the model regarding (a) the
structural behavior and (b) the pedestrian-induced load. Involving the structural model, the main uncertainty concerns the modal damping ratios.
However, the covariance of the modal parameters as obtained from the SSI-cov14 were low and, in addition, the free decay analyses show that
the modal damping ratios hardly depend on the vibration amplitudes3. Concerning the pedestrian excitation, the identified time-variant pacing
rate is an approximation of the real imperfect walking behavior whereby small differences may arise due to the application of the generalized
force model. The difference in amplitude between the predicted and the measured response in Figures 13-15 is striking and cannot simply
result from these remaining uncertainties. It can, however, be explained by an increased damping, i.e., due to the changes in the dynamic
properties of the coupled human-structure system in comparison to those of the empty structure. However, accounting for the involved time-
variant pacing rates allows to quantify the remaining discrepancy that is due to these human-structure interaction (HSI) effects10,15-17. In this way,
the methodology presented here provides essential input for the verification of the human-induced loads and quantification of HSI-effects.

 

Figure 1. (A) The Xsens - Mtw Development Kit consisting of multiple wireless inertial units (MTw's)2, (B) platform designed to define the
orientation reference frame, and (C) the specially designed click-in full body straps2. Please click here to view a larger version of this figure.

 

Figure 2. The force plate4 applied to register the GRFs during jumping/bobbing. Please click here to view a larger version of this figure.
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Figure 3. Wireless triaxial Geosig sensors5 applied to register the structural accelerations. Please click here to view a larger version of this
figure.

 

Figure 4. Configuration setup for the laboratory experiments involving human rhythmical experiments. Please click here to view a larger
version of this figure.

 

Figure 5. (A) The Eeklo footbridge and (B) synchronized walking of six participants (this figure has been modified from [3]). Please click here to
view a larger version of this figure.
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Figure 6. The PediVib Toolbox8 applied to simulate the human-induced vibrations. Please click here to view a larger version of this figure.

 

Figure 7. The linear spectrum of (A) the vertical GRFs (sum of left and right foot) and (B) the corresponding acceleration levels near the CoM
(this figure has been modified from [3]). Please click here to view a larger version of this figure.
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Figure 8. The normalized (A-C) vertical single step (dashed) and continuous (solid) GRFs (B-D) the normalized accelerations near the CoM and
(A-B) the identified timing of nominally identical events (vertical line) from the GRFs (solid) and the accelerations near the CoM (dashed) (this
figure has been modified from [3]). Please click here to view a larger version of this figure.

 

Figure 9. The normalized measured (solid) and corresponding simulated (dashed) vertical GRFs during walking (this figure has been
modified from [3]). Please click here to view a larger version of this figure.

 

Figure 10. The amplitude spectrum of the measured (black) and simulated (grey) vertical GRFs (this figure has been modified from [3]).
Please click here to view a larger version of this figure.
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Figure 11. The identified walking behavior of six pedestrians: (A) each step of every person indicated by a single vertical line (B) the
synchronization rate, and (C-D) corresponding simulated vertical forces induced by left (grey) and right (black) foot (this figure has been modified
from [3]). Please click here to view a larger version of this figure.

 

Figure 12. The experimentally identified modal parameters of the first six modes of the Eeklo footbridge: natural frequency (fj), modal
damping ratio (ξj) and mode shape: (A) mode 1 (f1 = 1.71 Hz, ξ1 = 2.3%); (B) mode 2 (f2 = 2.99 Hz, ξ2 = 0.2%); (C) mode 3 (f3 = 3.25 Hz, ξ3 =
1.5%); (D) mode 4 (f4 = 3.46 Hz, ξ4 = 3.0%); (E) mode 5 (f5 = 5.77 Hz, ξ5 = 0.2%); and (F) mode 6 (f6 = 5.82 Hz, ξ6 = 0.2%). Please click here to
view a larger version of this figure.
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Figure 13. The accelerations at midspan for persons walking (A) two by two at a pacing rate targeted at fs = f2/2 and (B) in single file at a pacing
rate fs = f1: measured (black) and predicted response without (grey) and with (blue) the in situ identified pacing rate (this figure has been modified
from [3]). Please click here to view a larger version of this figure.

 

Figure 14. The accelerations at midspan for persons jumping at a pacing rate targeted at (A) fs = f2/2 and (B) fs = f1: measured (black) and
predicted response without (grey) and with (blue) the in situ identified pacing rate. Please click here to view a larger version of this figure.

 

Figure 15. The accelerations at midspan for persons bobbing at a pacing rate targeted at (A) fs = f2/2 and (B) fs = f1: measured (black) and
predicted response without (grey) and with (blue) the in situ identified pacing rate. Please click here to view a larger version of this figure.

Walking speed Step frequency # steps CoM

[km/hr] [Hz] [-] 2σ [%]

3.0 1.55 166 2.8

3.5 1.68 178 2.3

4.0 1.75 1.82 2.1

4.5 1.85 182 2.0

5.0 1.92 193 2.1

5.5 2.00 215 2.0

6.0 2.06 217 2.1

Table 1. For each trial: the different walking speeds, the mean step frequency, the number of registered steps and the 95% confidence
interval of the identified onset of each step based on the motion registered near the CoM (this table has been modified from [3]).

Discussion

The human motion and resulting GRFs are usually identified by the application of force plates, instrumented treadmills as well as optical motion
capture technology such as Vicon18 and CODA19. The application of these techniques is, however, restricted to the laboratory environment. In
answer to this drawback, the potential of innovative techniques that permit the measurement of 'natural' person behavior over many repeated
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and uninterrupted cycles is currently investigated20. Alternative techniques include the use of pressure sensitive insole systems21 or instrumented
shoes22. These systems allow for the direct measurement of contact forces on structures but generally only yield the vertical component and
do not capture the global body behavior, e.g., the trunk motion20. Another ambulant technique employs combined magnetic-inertial sensors,
i.e., accelerometry20,23. Although this wireless technology is also encountering some challenges (e.g., soft-tissue artefacts24, connectivity, etc.),
it offers great potential for the indirect characterization of human-induced loading as well as for the analysis of individual, group and crowd
behavior23,24. In the present study, a 3D inertial motion tracking technique developed for the movement science and entertainment industry is
examined and a methodology is developed for the in-field characterization of the human motion and the resulting GRFs.

A first essential step in the method presented here consists of a comprehensive experimental study in laboratory conditions in which the human
motion and the GRFs are registered simultaneously. This dataset should comprise a relevant set of pacing rates and individuals for each of the
human activities in focus. Subsequently, this dataset can be applied to identify the relation between the registered motion of the participants and
the resulting GRFs. Next, a procedure can be developed for the identification of the timing of nominally identical events in each loading cycle
from both the registered motion and the corresponding GRFs. In this way, these datasets not only serve as validation for the procedure aiming to
characterize the human-induced loads, but, also allows to quantify the corresponding accuracy.

Secondly, the synchronization between the involved measurement systems is of high importance. The latter is preferably accomplished by
the use of a single data acquisition system or a shared trigger channel2. A well-designed and consistently executed protocol (as previously
discussed) can serve as a useful alternative, especially for application in situ.

The procedure as discussed in the present work operates perfectly up to 10 or 12 participants. However, as the number of participants further
increases and, thus, as the number of wireless motion tracking units increases, the corresponding data acquisition system requires the sampling
rate to reduce significantly. Although cumbersome, the measurement system can be extended by multiple Xsens data acquisition stations for
which, in turn, the data is synchronized through the application of a common trigger channel. When the aim is to monitor the behavior of larger
groups and crowds, the application of alternative techniques such as video/image processing could be explored.

In situ observations are the only source of information to obtain detailed and accurate information on representative operational loading data.
Further research will therefore include full-scale measurements on real footbridges involving large groups and crowds. The present technique
can be applied to identify the natural walking behavior of the participants and, thereby, provide essential input for the development of suitable
models for the correlation among pedestrians in real traffic conditions. In addition, the identified walking behavior, in combination with currently
available load models, can be applied to simulate the induced structural response. Comparison with the corresponding measured structural
vibrations allows to verify and calibrate the applied load models, e.g., by estimating the relevant human-structure interaction phenomena such as
added damping.
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